Microsoft Word
Step by Step
(Microsoft 365 and Office 2021)

Joan Lambert
Contents

Acknowledgments ........................................................ xi
About the author ......................................................... xii
Who this book is for ...................................................... xiii
The Step by Step approach ............................................. xiii
Features and conventions ................................................. xiv
Download the practice files ............................................ xv
E-book edition ........................................................... xix
Get support and give feedback ........................................ xix
  Errata and support ................................................... xix
  Stay in touch ......................................................... xix
Sidebar: Adapt exercise steps ........................................ xx

Part 1: Get started with Microsoft Word 365

1 Word basics ............................................................ 3
   Start Word ............................................................ 4
   Work in the Word user interface .................................. 5
     Identify app window elements .................................. 7
     Sidebar: About Microsoft 365 apps............................ 8
     Work with the ribbon and status bar......................... 16
     Sidebar: Adapt procedures for your environment .......... 18
     Sidebar: Discover new features ............................... 25
   Manage Microsoft 365 app settings ............................ 26
     Sidebar: Microsoft account options .......................... 27
   Get help and provide feedback .................................. 31
   Key points .......................................................... 36
   Practice tasks ...................................................... 37
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create and manage documents</td>
<td>41</td>
</tr>
<tr>
<td>Create documents</td>
<td>42</td>
</tr>
<tr>
<td>Open and move around in documents</td>
<td>47</td>
</tr>
<tr>
<td>Open existing documents</td>
<td>47</td>
</tr>
<tr>
<td>Sidebar: Open documents in Protected View</td>
<td>50</td>
</tr>
<tr>
<td>Sidebar: Open and edit PDF files in Word</td>
<td>51</td>
</tr>
<tr>
<td>Move around in documents</td>
<td>52</td>
</tr>
<tr>
<td>Display different views of documents</td>
<td>56</td>
</tr>
<tr>
<td>Display and edit file properties</td>
<td>63</td>
</tr>
<tr>
<td>Save and close documents</td>
<td>64</td>
</tr>
<tr>
<td>Manually save documents</td>
<td>65</td>
</tr>
<tr>
<td>Sidebar: Save files to OneDrive</td>
<td>68</td>
</tr>
<tr>
<td>Automatically save documents</td>
<td>70</td>
</tr>
<tr>
<td>Save documents in other formats</td>
<td>70</td>
</tr>
<tr>
<td>Sidebar: Maintain compatibility with earlier versions of Word</td>
<td>73</td>
</tr>
<tr>
<td>Close documents</td>
<td>74</td>
</tr>
<tr>
<td>Key points</td>
<td>75</td>
</tr>
<tr>
<td>Practice tasks</td>
<td>76</td>
</tr>
<tr>
<td>Enter and edit text</td>
<td>81</td>
</tr>
<tr>
<td>Enter and import text</td>
<td>82</td>
</tr>
<tr>
<td>Select, move, copy, and delete text</td>
<td>85</td>
</tr>
<tr>
<td>Sidebar: Paste options</td>
<td>90</td>
</tr>
<tr>
<td>Find and replace text</td>
<td>93</td>
</tr>
<tr>
<td>Use reference and research tools</td>
<td>98</td>
</tr>
<tr>
<td>Sidebar: Install Office tools</td>
<td>99</td>
</tr>
<tr>
<td>Sidebar: Display document statistics</td>
<td>101</td>
</tr>
<tr>
<td>Key points</td>
<td>103</td>
</tr>
<tr>
<td>Practice tasks</td>
<td>104</td>
</tr>
</tbody>
</table>
## Part 2: Create professional documents

<table>
<thead>
<tr>
<th>Modify the structure and appearance of text</th>
<th>111</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply paragraph formatting</td>
<td>112</td>
</tr>
<tr>
<td>Configure alignment</td>
<td>113</td>
</tr>
<tr>
<td>Configure vertical spacing</td>
<td>114</td>
</tr>
<tr>
<td>Configure indents</td>
<td>118</td>
</tr>
<tr>
<td>Sidebar: Configure paragraph borders and shading</td>
<td>121</td>
</tr>
<tr>
<td>Structure content manually</td>
<td>122</td>
</tr>
<tr>
<td>Apply character formatting</td>
<td>126</td>
</tr>
<tr>
<td>Sidebar: Character formatting and case considerations</td>
<td>131</td>
</tr>
<tr>
<td>Sidebar: Format the first letter of a paragraph as a drop cap</td>
<td>133</td>
</tr>
<tr>
<td>Create and modify lists</td>
<td>134</td>
</tr>
<tr>
<td>Sidebar: Format text as you type</td>
<td>139</td>
</tr>
<tr>
<td>Apply built-in styles to text</td>
<td>140</td>
</tr>
<tr>
<td>Apply styles</td>
<td>140</td>
</tr>
<tr>
<td>Manage outline levels</td>
<td>145</td>
</tr>
<tr>
<td>Change the document theme</td>
<td>147</td>
</tr>
<tr>
<td>Key points</td>
<td>151</td>
</tr>
<tr>
<td>Practice tasks</td>
<td>152</td>
</tr>
</tbody>
</table>

## Organize information in columns and tables

| Present information in columns              | 158 |
| Create tabbed lists                        | 166 |
| Present information in tables              | 168 |
| Sidebar: Insert spreadsheet content into a document | 170 |
| Sidebar: Other table layout options         | 176 |
| Format tables                              | 183 |
| Sidebar: Quick Tables                      | 188 |
| Key points                                | 190 |
| Practice tasks                             | 191 |
## Insert and modify charts

- **Insert and modify charts** .................................................. 269
- Create charts ........................................................................ 270
- Sidebar: Custom chart templates ........................................ 274
- Modify charts ....................................................................... 275
- Manage chart data .............................................................. 275
- Modify the display of chart elements .................................... 278
- Sidebar: Pie charts .............................................................. 283
- Format charts ....................................................................... 284
- Key points ............................................................................ 288
- Practice tasks ....................................................................... 289

## Format document elements

- **Format document elements** ................................................. 293
- Format the page background ............................................... 294
- Insert a background watermark .......................................... 300
- Insert headers, footers, and page numbers ......................... 305
- Insert preformatted document parts .................................... 310
  - Sidebar: Insert and link custom text boxes ....................... 316
- Key points ............................................................................ 317
- Practice tasks ....................................................................... 318

## Organize and arrange content

- **Organize and arrange content** .......................................... 321
- Reorganize document outlines ............................................. 322
  - Manage content in the Navigation pane ......................... 322
  - Manage content in Outline view ..................................... 324
- Arrange objects on a page ................................................... 328
- Use tables to control page layout ...................................... 338
  - Sidebar: Structure content for accessibility .................... 339
- Key points ............................................................................ 341
- Practice tasks ....................................................................... 342
Part 4: Review and finalize documents

**Collaborate on documents** .......................................................... 347
  - Mark up documents .......................................................... 348
    - Insert comments .......................................................... 348
    - Track changes ............................................................ 350
  - Display and review document markup .................................... 354
    - Display markup .......................................................... 355
    - Review and respond to comments .................................... 360
    - Review and process tracked changes ................................. 363
  - Compare and combine documents ......................................... 365
    - Compare and combine separate copies of a document .......... 365
    - Sidebar: Remember to check for errors ............................ 365
    - Compare separate versions of a document ......................... 369
  - Control content changes ..................................................... 370
    - Restrict actions .......................................................... 370
    - Restrict access by using a password ................................ 376
  - Coauthor documents .......................................................... 380
  - Key points ................................................................. 386
  - Practice tasks ............................................................. 387

**Finalize and distribute documents** .............................................. 391
  - Locate and correct text errors ......................................... 392
  - Preview and adjust page layout .......................................... 403
  - Control what appears on each page .................................... 409
  - Prepare documents for electronic distribution ...................... 414
    - Sidebar: Accessibility issues ....................................... 418
  - Print and send documents .................................................. 421
  - Key points ................................................................. 427
  - Practice tasks ............................................................. 428
Part 5: Use advanced Word functions

13
Reference content and content sources ........................................ 433
Insert bookmarks and cross-references ........................................ 434
   Sidebar: Hyperlink to additional resources ................................ 438
Display document information in fields ...................................... 440
Insert and modify footnotes and endnotes .................................... 444
Create and modify tables of contents ......................................... 446
   Sidebar: Other reference tables ........................................... 451
Create and modify indexes ....................................................... 453
Cite sources and compile bibliographies ..................................... 460
Key points .............................................................................. 466
Practice tasks .......................................................................... 467

14
Merge data with documents and labels ....................................... 473
Understand the mail merge process ............................................ 474
Start the mail merge process ..................................................... 475
   Get started with letters ......................................................... 476
   Get started with labels ......................................................... 477
   Get started with email messages .......................................... 480
   Sidebar: Attaching files to email merge messages ..................... 481
Choose and refine the data source .............................................. 482
   Select an existing data source .............................................. 483
   Create a new data source .................................................... 486
   Refine the data source records .......................................... 487
   Sidebar: Refresh data ........................................................ 492
Insert merge fields .................................................................... 492
Preview and complete the merge ............................................... 495
Create individual envelopes and labels ...................................... 497
   Generate individual envelopes .......................................... 498
   Generate individual mailing labels .................................... 502
Key points .............................................................................. 504
Practice tasks .......................................................................... 505
Acknowledgments

Every book represents the combined efforts of many individuals. First and foremost, I must extend my deep appreciation to Paul McFedries for jumping into the void to contribute to many chapters of this edition of the book. Paul is the author of several books in the *Step by Step* series. We’ve worked together on a few, although we’ve never met in person.

At Pearson, I’m thankful to Loretta Yates for the continuing opportunity to be part of this series, to Charvi Arora and Malobika Chakraborty for keeping things on track, and to Tracey Croom for overseeing the production process.

Laura Acklen performed the technical review of this book, helping us to catch some of the many changes Microsoft rolled out to Word between the time we started and the time we finished creating this content. I’m sure there will be more by the time this book reaches your hands! Please use the feedback mechanism described in the Introduction to let us know about any issues you find.

It was a pleasure to work once again with the production team of Dan Foster (copy editor and absolutely priceless backup developmental editor and technical reviewer), Danielle Foster (compositor and graphics processor), Valerie Haynes Perry (indexer), and Scout Festa (proofreader). They are consummate professionals, and I become a better author each time I work with them.

As always, many thanks and all my love to my divine daughter, Trinity Preppernau.
About the author

**Joan Lambert** is a certified expert in accessibility, training, Adobe InDesign, Intuit QuickBooks, Dynamics, Windows Server technologies, and many Microsoft applications and systems including Access, Excel, OneNote, Outlook, PowerPoint, SharePoint, Windows, and Word. A former small business owner and recovering workaholic, she has worked for over 36 years with Microsoft and Microsoft technologies and for over 26 years in the training and certification industry.

As a member of the Pearson VUE Accessibility team since 2022, Joan has gained a new perspective on computer interactions and the importance of providing equitable access to technology and content. Through her books, Joan enjoys helping people gain confidence and increase their productivity. She has written more than 50 books about Windows, Office, and SharePoint technologies, including dozens of *Step by Step* books and five generations of Microsoft Office Specialist certification study guides. Students who use the *GO! with Microsoft Office* textbook products from Pearson may overhear her cheerfully demonstrating Office features in the videos that accompany the series.

A native of the Pacific Northwest, Joan has had the good fortune to live in many parts of the world—including Germany, New Zealand, Sweden, and Denmark—and many of our United States. She currently resides with her family—one daughter, two dogs, two cats, and five chickens—in the Beehive State, where she enjoys the majestic mountain views, mostly blue skies, and occasional snowstorm.
Introduction

Welcome! This *Step by Step* book has been designed so you can read it from the beginning to learn about Microsoft Word 365 (or Word 2021) and then build your skills as you learn to perform increasingly specialized procedures. Or, if you prefer, you can jump in wherever you need guidance for performing tasks. The how-to steps are delivered crisply and concisely—just the facts. You’ll also find informative graphics that support the instructional content.

Who this book is for

*Microsoft Word Step by Step (Microsoft 365 and Office 2021)* is designed for use as a learning and reference resource by people who want to use Word to create and edit documents, and who want to make use of the many features that help users achieve an attractive and professional result. The book content is designed to be useful for people who are upgrading from earlier versions of Word and for people who are discovering Word for the first time.

The *Step by Step* approach

This book’s coverage is divided into parts representing general Word skill sets. Each part is divided into chapters representing skill set areas, and each chapter is divided into topics that group related skills. Each topic includes expository information followed by generic procedures. At the end of the chapter, you’ll find a series of practice tasks that you can complete on your own by using the skills taught in the chapter. You can use the practice files available from this book’s website to work through the practice tasks, or you can use your own files.
Features and conventions

This book has been designed to lead you step by step through tasks you’re likely to want to perform in Word. The topics are all self-contained, so you can start at the beginning and work your way through all the procedures or reference them independently. If you have worked with a previous version of Word, or if you complete all the exercises and later need help remembering how to perform a procedure, the following features of this book will help you locate specific information:

- **Detailed table of contents**  Browse the listing of the topics, sections, and sidebars within each chapter.

- **Chapter thumb tabs and running heads**  Identify the pages of each chapter by the thumb tabs on the book pages’ open fore edge. Find a specific chapter by number or title by looking at the running heads at the top of even-numbered (verso) pages.

- **Topic-specific running heads**  Within a chapter, quickly locate the topic you want by looking at the running heads at the top of odd-numbered (recto) pages.

- **Practice tasks page tabs**  Easily locate the practice tasks at the end of each chapter by looking for the full-page stripe on the book’s fore edge.

- **Detailed index**  Look up coverage of specific tasks and features in the index at the back of the book.

You can save time when reading this book by understanding how the *Step by Step* series provides procedural instructions and auxiliary information and identifies on-screen and physical elements that you interact with. The following table lists content formatting conventions used in this book.
### Convention | Meaning
---|---
**TIP** | This reader aid provides a helpful hint or shortcut to simplify a task.
**IMPORTANT** | This reader aid alerts you to a common problem or provides information necessary to successfully complete a procedure.
**SEE ALSO** | This reader aid directs you to more information about a topic in this book or elsewhere.
1. Numbered steps | Numbered steps guide you through generic procedures in each topic and hands-on practice tasks at the end of each chapter.
2. | 
3. | 
- **Bulleted lists** | Bulleted lists indicate single-step procedures and sets of multiple alternative procedures.
**Interface objects** | In procedures and practice tasks, semibold black text indicates on-screen elements that you should select (click or tap).
**User input** | Light semibold formatting identifies specific information that you should enter when completing procedures or practice tasks.
**Ctrl+P** | A plus sign between two keys indicates that you must select those keys at the same time. For example, “press Ctrl+P” directs you to hold down the Ctrl key while you press the P key.
**Emphasis and URLs** | In expository text, italic formatting identifies web addresses and words or phrases we want to emphasize.

### Download the practice files

Before you can complete the practice tasks in this book, you must download the book’s practice files to your computer from:

MicrosoftPressStore.com/Word365SBS/downloads

Follow the instructions on the webpage.

**IMPORTANT** Word and other Microsoft 365 apps are not available from this book’s website. You should install Word 365 from the Microsoft 365 desktop app or from www.microsoft.com/microsoft-365, or install Word 2021, before working through the procedures and practice tasks in this book.
You can open the files that are supplied for the practice tasks and save the finished versions of each file. If you want to repeat practice tasks later, you can download the original practice files again.

**SEE ALSO** For information about opening and saving files, see “Open and move around in documents” in Chapter 2, “Create and manage documents.”

The following table lists the files available for use while working through the practice tasks in this book.

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Folder</th>
<th>File</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Part 1: Get started with Microsoft Word</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1: Word basics</td>
<td>Word365SBS\Ch01</td>
<td>None</td>
</tr>
<tr>
<td>2: Create and manage documents</td>
<td>Word365SBS\Ch02</td>
<td>DisplayViews.docx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>EditProperties.docx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>NavigateFiles.docx</td>
</tr>
<tr>
<td>3: Enter and edit text</td>
<td>Word365SBS\Ch03</td>
<td>EditText.docx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FindText.docx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ImportText.docx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ResearchText.docx</td>
</tr>
<tr>
<td><strong>Part 2: Create professional documents</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4: Modify the structure and appearance of text</td>
<td>Word365SBS\Ch04</td>
<td>ApplyStyles.docx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>ChangeTheme.docx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CreateLists.docx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FormatCharacters.docx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FormatParagraphs.docx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>StructureContent.docx</td>
</tr>
<tr>
<td>5: Organize information in columns and tables</td>
<td>Word365SBS\Ch05</td>
<td>AddColumns.docx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CreateTabbedLists.docx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CreateTables.docx</td>
</tr>
<tr>
<td></td>
<td></td>
<td>FormatTables.docx</td>
</tr>
<tr>
<td>Chapter</td>
<td>Folder</td>
<td>File</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>------</td>
</tr>
<tr>
<td>6: Add simple graphic elements</td>
<td>Word365SBS\Ch06</td>
<td>AddInformation.docx Bamboo1.jpg EditPictures.docx InsertClippings.docx InsertIcons.docx InsertPictures.docx</td>
</tr>
<tr>
<td>Part 3: Enhance document content</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7: Insert and modify diagrams and 3D models</td>
<td>Word365SBS\Ch07</td>
<td>Astronaut.glb Chickens.jpg Create3DModels.docx CreateDiagrams.docx CreatePictograms.docx Fish.jpg Globe.glb ModifyDiagrams.docx Penguins.jpg Tiger.jpg</td>
</tr>
<tr>
<td>8: Insert and modify charts</td>
<td>Word365SBS\Ch08</td>
<td>CreateCharts.docx FormatCharts.docx ModifyCharts.docx Temperatures.xlsx</td>
</tr>
<tr>
<td>9: Format document elements</td>
<td>Word365SBS\Ch09</td>
<td>AddWatermarks.docx Clouds.jpg InsertBuildingBlocks.docx InsertHeadersFooters.docx Logo.jpeg</td>
</tr>
<tr>
<td>10: Organize and arrange content</td>
<td>Word365SBS\Ch10</td>
<td>ArrangeObjects.docx Bamboo1.jpg Bamboo2.jpg ControlLayout.docx ReorganizeOutlines.docx</td>
</tr>
<tr>
<td>Chapter</td>
<td>Folder</td>
<td>File</td>
</tr>
<tr>
<td>---------</td>
<td>--------</td>
<td>------</td>
</tr>
<tr>
<td><strong>Part 4: Review and finalize documents</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>11: Collaborate on documents</td>
<td>Word365SBS\Ch11</td>
<td>ControlChanges.docx&lt;br&gt;MergeDocs1.docx&lt;br&gt;MergeDocs2.docx&lt;br&gt;ReviewComments.docx&lt;br&gt;TrackChanges.docx</td>
</tr>
<tr>
<td>12: Finalize and distribute documents</td>
<td>Word365SBS\Ch12</td>
<td>ControlLayout.docx&lt;br&gt;CorrectErrors.docx&lt;br&gt;PrepareDocument.docx&lt;br&gt;PreviewPages.docx&lt;br&gt;PrintDocument.docx</td>
</tr>
<tr>
<td><strong>Part 5: Use advanced Word functions</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>13: Reference content and content sources</td>
<td>Word365SBS\Ch13</td>
<td>CompileBibliography.docx&lt;br&gt;CreateIndexes.docx&lt;br&gt;CreateTOC.docx&lt;br&gt;DisplayFields.docx&lt;br&gt;InsertBookmarks.docx&lt;br&gt;InsertFootnotes.docx</td>
</tr>
<tr>
<td>14: Merge data with documents and labels</td>
<td>Word365SBS\Ch14</td>
<td>CreateEnvelopes.docx&lt;br&gt;CustomerList.csv&lt;br&gt;CustomerList.xlsx&lt;br&gt;InsertFields.docx&lt;br&gt;PolicyholdersList.xlsx&lt;br&gt;RefineData.docx&lt;br&gt;StartMerge.docx</td>
</tr>
<tr>
<td>15: Create custom document elements</td>
<td>Word365SBS\Ch15</td>
<td>ChangeTheme.docx&lt;br&gt;CreateBuildingBlocks.docx&lt;br&gt;CreateStyles.docx&lt;br&gt;CreateTemplates.docx&lt;br&gt;CreateThemes.docx</td>
</tr>
<tr>
<td>16: Customize options and the user interface</td>
<td>Word365SBS\Ch16</td>
<td>None</td>
</tr>
</tbody>
</table>
E-book edition

If you’re reading the e-book edition of this book, you can do the following:

- Search the full text
- Print
- Copy and paste

You can purchase and download the e-book edition from the Microsoft Press Store at:

MicrosoftPressStore.com/Word365SBS/detail

Get support and give feedback

We’ve made every effort to ensure the accuracy of this book and its companion content. We welcome your feedback.

Errata and support

If you discover an error, please submit it to us at:

MicrosoftPressStore.com/Word365SBS/errata

We’ll investigate all reported issues, update downloadable content if appropriate, and incorporate necessary changes into future editions of this book.

For additional book support and information, please visit:

MicrosoftPressStore.com/Support

For assistance with Microsoft software and hardware, visit the Microsoft Support site at:

support.microsoft.com

Stay in touch

Let’s keep the conversation going! We’re on Twitter at twitter.com/MicrosoftPress.
Adapt exercise steps

This book contains many images of the Word user interface elements (such as the ribbon and the app window) that you’ll work with while performing tasks in Word 365 on a Windows computer. Unless we’re demonstrating an alternative view of content, the screenshots shown in this book were captured on a horizontally oriented display at a screen resolution of 1920 × 1080 and a magnification of 100 percent. If your settings are different, the ribbon on your screen might not look the same as the one shown in this book. As a result, exercise instructions that involve the ribbon might require a little adaptation.

Simple procedural instructions use this format:

- On the **Insert** tab, in the **Illustrations** group, select the **Chart** button.

If the command is in a list, our instructions use this format:

- On the **Home** tab, in the **Editing** group, select the **Find** arrow and then, in the **Find** list, select **Go To**.

If differences between your display settings and ours cause a button to appear differently on your screen than it does in this book, you can easily adapt the steps to locate the command. First select the specified tab, and then locate the specified group. If a group has been collapsed into a group list or under a group button, select the list or button to display the group’s commands. If you can’t immediately identify the button you want, point to likely candidates to display their names in ScreenTips.
Multistep procedural instructions use this format:

1. To select the paragraph that you want to format in columns, triple-click the paragraph.

2. On the **Layout** tab, in the **Page Setup** group, select the **Columns** button to display a menu of column layout options.

3. On the **Columns** menu, select **Three**.

On subsequent instances of instructions that require you to follow the same process, the instructions might be simplified in this format because the working location has already been established:

1. Select the paragraph that you want to format in columns.

2. On the **Columns** menu, select **Three**.

The instructions in this book assume that you’re selecting on-screen content and user interface elements on your computer by clicking (with a mouse, touchpad, or other hardware device) or tapping a touchpad or the screen (with your finger or a stylus). Instructions refer to Word user interface elements that you click or tap on the screen as *buttons*, and to physical buttons that you press on a keyboard as *keys*, to conform to the standard terminology used in documentation for these products.

When the instructions tell you to enter information, you can do so by typing on a connected external keyboard, tapping an on-screen keyboard, or even speaking aloud, depending on your computer setup and your personal preferences.
Pearson’s Commitment to Diversity, Equity, and Inclusion

Pearson is dedicated to creating bias-free content that reflects the diversity of all learners. We embrace the many dimensions of diversity, including but not limited to race, ethnicity, gender, socioeconomic status, ability, age, sexual orientation, and religious or political beliefs.

Education is a powerful force for equity and change in our world. It has the potential to deliver opportunities that improve lives and enable economic mobility. As we work with authors to create content for every product and service, we acknowledge our responsibility to demonstrate inclusivity and incorporate diverse scholarship so that everyone can achieve their potential through learning. As the world’s leading learning company, we have a duty to help drive change and live up to our purpose to help more people create a better life for themselves and to create a better world.

Our ambition is to purposefully contribute to a world where:

- Everyone has an equitable and lifelong opportunity to succeed through learning.
- Our educational products and services are inclusive and represent the rich diversity of learners.
- Our educational content accurately reflects the histories and experiences of the learners we serve.
- Our educational content prompts deeper discussions with learners and motivates them to expand their own learning (and worldview).

While we work hard to present unbiased content, we want to hear from you about any concerns or needs with this Pearson product so that we can investigate and address them.

Please contact us with concerns about any potential bias at https://www.pearson.com/report-bias.html.
Create and manage documents

Using Microsoft Word, you can create many different types of documents, for many different purposes. Word is widely used in schools, businesses, and many kinds of organizations to create letters, newsletters, reports, résumés, and other documents that contain text. Word provides a lot of flexibility in document design, so you can also create documents that contain images and content that doesn’t fit a standard sheet of paper, such as mailing labels, trifold brochures, greeting cards, business cards, certificates, and signs.

You can open and work with documents from a variety of locations. Word introduces methods of quickly accessing documents from multiple computers that can save you time and conserve storage space. When working in a Word document, you can display different views of the content and the document structure, and use different methods to move around within the document. You can also display and modify document properties, such as the name of the document author and any keywords that apply to the document.

This chapter guides you through procedures related to creating documents, opening and moving around in documents, displaying different views of documents, displaying and editing file properties, and saving and closing documents.

In this chapter

- Create documents
- Open and move around in documents
- Display different views of documents
- Display and edit file properties
- Save and close documents
Create documents

All documents are based on templates. Even when you create a “blank” document, that document is based on the default Normal template in Word. You can create a blank document of the default file type or create a document with a predefined design, such as one of the other templates provided with Word. Each non-blank template incorporates specific design elements such as fonts and colors. Most non-blank templates also include typical information that you can modify or build on to create a useful document.

When you start Word, the app displays the Home page that gives you options for opening an existing file or creating a new one. In the New section, you see several templates, including Blank document, which creates a new, empty document based on the Normal template. In the Home page, you can select More templates to open the New page of the Backstage view.

The Home page appears by default but can be disabled

TIP The document templates available in Word include standard templates that have been available for many years and featured templates that change occasionally. The templates on the New page of the Backstage view in your installation of Word might be different from those shown in images in this book.
If you’re already working in Word, you can create a new document from the New page of the Backstage view. The same templates and search options are available from both the Home page and the New page.

Word provides document templates for a wide variety of purposes

If you create custom templates and save them in your Custom Office Templates folder, Featured and Personal links appear below the search box on the New page. You can select these links to switch between viewing app-supplied templates on the Featured page and your custom templates on the Personal page.

SEE ALSO For information about creating custom templates, see “Create and attach templates” in Chapter 15, “Create custom document elements.”

You can start with a blank document that contains one page. You can then add content, apply structure and design elements, and make any necessary configuration changes.
New blank documents are based on the built-in Normal template by default. You can save time by basing your document on a content template and then customizing the content provided in the template to meet your needs.

Most Word templates are for specific types of documents, and many are pre-populated with text, tables, images, and other content that you can modify to fit your needs. A few of the templates are installed on your computer with Word. Many more templates are maintained on the Microsoft 365 website, but you can locate and use them directly from within Word (provided you have an internet connection).

- The available templates vary depending on whether you’re working online or offline. When you’re working online (that is, when your computer has an active internet connection, regardless of whether you’re using it to do anything else), the New page displays thumbnails of featured templates. These vary based on the season; for example, they might include holiday-specific or season-specific templates for creating announcements, invitations, and newsletters. The search box is active; you can enter a search term to display related online templates, or select a category below the search box to display online templates in that category.

- When you’re working offline, the New page displays only templates stored on your computer. These include any templates that you’ve already used and a selection of letter, newsletter, report, and résumé templates. The search box is unavailable; you can only search the offline templates by scrolling through the thumbnails on the New page.

Word document templates contain elements such as the following:

- **Formatting** Most templates contain formatting, which in addition to styles can include page-layout settings, backgrounds, and themes. A template that contains only formatting defines the look of the document; you add your own content.

- **Text** Templates can also contain text that you customize for your own purposes. For example, if you base a new document on an agenda template from the Microsoft 365 website, the text of the agenda is already in place; all you have to do is customize it. Sometimes, a document based on a template displays formatted text placeholders surrounded by square brackets—for example, [Company Name]—instead of actual text. You replace a placeholder with your own text by selecting the placeholder and then typing the replacement. If you don’t need a placeholder, you can delete it.
Graphics, tables, charts, and diagrams  Templates can contain ready-made graphic elements, either for use as is or as placeholders for elements tailored to the specific document.

Building blocks  Some templates make custom building blocks, such as headers and footers or a cover page, available for use with a particular type of document. They might also include AutoText, such as contact information or standard copyright or privacy policies.

SEE ALSO For information about working with building blocks, see “Insert preformatted document parts” in Chapter 9, “Format document elements,” and “Create custom building blocks” in Chapter 15.

Custom tabs, commands, and macros  Sophisticated templates might include custom ribbon tabs or toolbars with commands and macros specific to the purposes of the template. A macro is a recorded series of commands that helps a user perform a process with minimal effort. The topic of macros is beyond the scope of this book; for information, refer to Word Help.

TIP Current Word template files have one of two file name extensions, depending on their content. Those that contain macros have the .dotm file name extension; those that don’t contain macros have the .dotx extension.

When you base a new document on a template, that template is attached to the document. The styles defined in the attached template appear in the Styles pane so that you can quickly apply them to any content you add to the document. You can change the document template by attaching a different one.

SEE ALSO For information about attaching templates to existing documents, see “Create and attach templates” in Chapter 15.

To create a new blank document

1. Start Word.
   
   Word automatically creates a blank document and displays the Home page of the Backstage view.

2. Press the Esc key to close the Backstage view.

Or
1. If Word is already running, select the File tab to display the Backstage view.

2. Do either of the following:
   - In the New section at the top of the Home page of the Backstage view, select the Blank document thumbnail.
   - In the left pane of the Backstage view, select New. Then on the New page of the Backstage view, select the Blank document thumbnail.

To preview design templates

1. Display the New page of the Backstage view.

2. On the New page, scroll through the pane to view the design templates that were installed with Word.

3. Select any thumbnail to open a preview window that displays a sample document page. Then do any of the following:
   - To create a document based on the template that is active in the preview window, select the Create button.
   - To view the next or previous template, select the arrow to the right or left of the preview window.
   - To close the preview window without creating a document, select the Close button in the upper-right corner of the preview window or click or tap outside the preview window.
To create a document based on an installed template
1. Display the New page of the Backstage view.
2. Scroll through the pane to locate the design you want to use.
3. Double-click the thumbnail to create the document.

To create a document based on an online template
1. Display the New page of the Backstage view.
2. Do either of the following to display templates related to a specific topic:
   - In the search box, enter a term related to the template content or design you’re looking for, and then select the Search button or press Enter.
   - Below the search box, select one of the suggested searches.
3. Scroll through the pane to locate a design that fits your needs.
4. Double-click any thumbnail to create a file based on the template.

To clear a template search
- To the left of the search box, select Back.

Open and move around in documents
In addition to templates, the Home page displays documents you’ve worked in recently, documents you’ve pinned to the page so they’re always available, and documents other people have shared with you.

Open existing documents
If the document you want to open appears on the Home page, you can open it directly from there. Otherwise, you can open documents stored locally on your computer or in a remote storage location such as a Microsoft OneDrive folder or a Microsoft SharePoint document library, either from within Word or from the document storage location.
TIP  If you receive a Word document as an attachment to an email message, you can open the attached document and start Word, if it isn’t already running, from within Outlook, or you can preview the document content directly in the Outlook Reading pane without starting Word.

IMPORTANT  Never open a Word document attached to an email message if you do not know the sender because malicious users can embed malware within Word files. Even if you know the sender, if you weren’t expecting the Word document, it’s best to check with the sender to make sure the file was sent legitimately (and not, say, by a malicious user having hijacked or spoofed that person’s email). For more information, see the sidebar “Open documents in Protected View” later in this chapter.

The Open page includes all the locations you’ve linked to from Microsoft 365 apps

The Open page displays only documents saved in the Word-specific file formats (.docx and .doc) and templates created for those standards. For more information about file formats, see “Save and close documents” later in this chapter.
The Recent list in the right pane of the Open page provides quick access to the documents you’ve worked with recently. The Recent list includes locally stored documents and documents that you’ve worked with while signed in with your current account on any computer, tablet, or other device, if the documents are stored in a shared location. This is one of the tremendous benefits of the Microsoft 365 subscription model and the cloud storage that comes with it: you can be up and running on a new computer in minutes, without having to move files or configure settings and preferences. If you use multiple computers, you can use this very convenient feature to seamlessly transition between computers without having to transport files (on a USB flash drive or hard drive) or maintain multiple copies of files in different locations.

**SEE ALSO** For more information about Microsoft 365 apps, see the sidebar “About Microsoft 365 Apps” in Chapter 1, “Word basics.”

To ensure that you can find a specific document quickly regardless of whether you’ve worked with it recently, you can pin it to your document list. On the Open page, pinned files appear in the Pinned section at the top of the list and are indicated by a thumbtack. On the Home page, they appear on the Pinned tab.

**To open a recent document**

1. Start Word.
2. On the **Home** page, in the **Recent** list, select the file name of the file you want to open.

**Or**

1. With Word running, select the **File** tab to display the Backstage view.
2. In the left pane of the Backstage view, select **Open** to display the Open page.
3. With **Recent** selected at the top of the left pane of the Open page, scroll through the file list in the right pane if necessary to locate the document you want to open. Then select the file name to open it.
Open documents in Protected View

When you open a document from an online location (such as a cloud storage location or email message) or from a location that has been deemed unsafe, Word opens the file in Protected View, with most editing functions disabled. This prevents any malicious code from gaining access to your computer. If you're uncertain about the origin of a file that you’re opening, you can choose to open the file in Protected View.

In Protected View, the title bar displays [Read-Only] to the right of the file name, and a yellow banner at the top of the content pane provides information about why the file has been opened in Protected View. If you know that the document is from a safe location or sender, and you want to edit the file content, you can choose to enable editing. If you don’t intend to modify the file content, you can hide the banner by selecting the Close button (the X) at its right end.

If you want to open documents from a specific online storage folder without going into Protected View, you can add that folder (and its subfolders, if you want) to your Trusted Locations list. For information about trusted locations and other Trust Center settings, see “Manage add-ins and security options” in Chapter 16, “Customize options and the user interface.”

To pin a document to the Recent file list

1. Display the Recent list on the Open page of the Backstage view.
2. If necessary, scroll through the list to locate the file you want to pin.
3. Point to the file name, and then select the Pin button that appears to the right of the file name to add the file to the Pinned area at the top of the Recent list on the Open page and to the Pinned tab on the Home page.

To open any existing document from within Word

1. Do either of the following to display the Open page of the Backstage view:
   - Start Word, and then select Open.
   - With Word running, display the Backstage view, and then select Open.
2. In the location list, select the local or network storage location where the file is stored.
3. Navigate to the file storage folder you want by using one of the following methods:

- In the right pane, select **Folders**. Then select pinned or recently accessed folders until you reach the folder you want.
- In the left pane, select **Browse** to display the Open dialog. Then select folders in the **Navigation** pane, double-click folders in the file pane, or enter the folder location in the **Address** bar.

4. Double-click the document you want to open.

---

**TIP** In the Open dialog, selecting a file name and then selecting the Open arrow displays a list of alternative ways to open the selected document. To look through a document without making any inadvertent changes, you can open the document as read-only, open a copy of the document, or open it in Protected View. You can also open the document in a web browser. In the event of a computer crash or other similar incident, you can instruct the app to open the document and try to repair any damage.

---

**Open and edit PDF files in Word**

A useful feature of Word is the ability to open PDF files and edit them by using all the standard Word features. When you finish, you can save the file as a document or as a PDF.

To open a PDF file in Word, do either of the following:

- In File Explorer, right-click or long-press (tap and hold) the PDF file, select **Open with**, and then select **Word**. If you don’t see Word in the list of apps, select **Choose another app**, select **Word**, and then select **Just once**.
- In Word, display the **Open** page of the Backstage view, navigate to the file location, select the file, and then select **Open**. (In the Open dialog, PDF files fall into the category of Word Documents.)

Word converts the file to an editable Word document. If the file contains complicated formatting and layout, the Word version of the document might not be a perfect replica of the PDF, but most simple files convert cleanly.
To open a file directly from a OneDrive storage site

1. In your web browser, navigate to the OneDrive folder.
2. Browse to and select the file you want to open.
3. If prompted to do so, enter the Microsoft account credentials associated with your OneDrive, and then select Sign in.

Or

1. In File Explorer, navigate to the OneDrive folder.
2. Browse to and double-click the file you want to open.
3. If prompted to do so, enter the Microsoft account credentials associated with your OneDrive, and then select Sign in.

Move around in documents

If you open a document that is too long or too wide to fit in the content pane, you can bring off-screen content into view without changing the location of the cursor by using the vertical and horizontal scroll bars. The scroll bars appear only when the document is longer or wider than the content pane. To remove distractions, the scroll bars and pointer fade from sight when you’re not using the mouse. You can make them reappear by moving the mouse.

You can also move around in a document by moving the cursor. You can place the cursor in a specific location by clicking or tapping there, or you can move the cursor different distances and in different directions and by pressing keyboard keys.

The cursor location is displayed on the status bar. By default, the status bar displays the page the cursor is on, but you can also display the cursor’s location by section, line number, and column, and in inches from the top of the page.

SEE ALSO  For information about displaying information on the status bar, see “Work with the ribbon and status bar” in Chapter 1.

In a long document, you might want to move quickly among elements of a certain type—for example, from heading to heading, from page to page, or from graphic to graphic. You can do this from the Navigation pane.
In the Navigation pane, you can move to the next object of a specific type.

SEE ALSO For information about working in the Navigation pane, see “Display different views of documents,” later in this chapter. For information about using the Navigation pane to search for specific content in a document, see “Find and replace text” in Chapter 3, “Enter and edit text.”

A greater variety of browsing options is available from the Go To tab of the Find and Replace dialog. From this tab, you can locate pages, sections, lines, bookmarks, comments, footnotes, endnotes, fields, tables, graphics, equations, objects, or headings. You can jump directly to a specific object if you know its position within the sequence of that type of object in the document (for example, if it is the fifth equation), move forward or backward a specific number of objects, or browse from one object to the next.
To change the area of a document that is displayed in the content pane

- On the vertical scroll bar, do any of the following:
  - Click or tap the scroll arrows to move up or down one line.
  - Click or tap above or below the scroll box to move up or down by the height of one screen.
  - Drag the scroll box on the scroll bar to display the part of the document corresponding to the location of the scroll box. For example, dragging the scroll box to the middle of the scroll bar displays the middle of the document.

- On the horizontal scroll bar, do any of the following to move side to side:
  - Click or tap the scroll arrows.
  - Click or tap to the left or right of the scroll box.
  - Drag the scroll box on the scroll bar to display the part of the document corresponding to the location of the scroll box.

To move the cursor by using the keyboard keys

- Move the cursor by pressing the key or key combination described in the following table.

<table>
<thead>
<tr>
<th>To move the cursor</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left one character</td>
<td>Left Arrow</td>
</tr>
<tr>
<td>Right one character</td>
<td>Right Arrow</td>
</tr>
<tr>
<td>Up one line</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Down one line</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Left one word</td>
<td>Ctrl+Left Arrow</td>
</tr>
<tr>
<td>Right one word</td>
<td>Ctrl+Right Arrow</td>
</tr>
<tr>
<td>Up one paragraph</td>
<td>Ctrl+Up Arrow</td>
</tr>
<tr>
<td>Down one paragraph</td>
<td>Ctrl+Down Arrow</td>
</tr>
<tr>
<td>To the beginning of the current line</td>
<td>Home</td>
</tr>
<tr>
<td>To the end of the current line</td>
<td>End</td>
</tr>
<tr>
<td>To the beginning of the document</td>
<td>Ctrl+Home</td>
</tr>
<tr>
<td>To the end of the document</td>
<td>Ctrl+End</td>
</tr>
</tbody>
</table>
To show or hide the Navigation pane in a document

- On the View tab, in the Show group, select the Navigation Pane checkbox.

To browse by object from the Navigation pane

- Open the Navigation pane, and then do any of the following:
  - At the top of the Navigation pane, select Headings. Then select any heading to move directly to that location in the document.
  - At the top of the Navigation pane, select Pages. Then select any thumbnail to move directly to that page of the document.
  - At the right end of the search box, select the arrow. In the Find list, select the type of object you want to browse by. Then select the Next and Previous arrows to move among those objects.

To display the Go To tab of the Find and Replace dialog

- On the Home tab, in the Editing group, select the Find arrow, and then Go To.
- In the Navigation pane, select the Search arrow, and then in the Search for more things list, select Go To.
- Press Ctrl+G.

To browse by object from the Go To What list

1. Display the Go To tab of the Find and Replace dialog.
2. In the Go to what list, select the type of object you want to search for. Then do any of the following:
   - Select the Next button to move to the next object of that type.
   - Select the Previous button to move to the previous object of that type.
In the text box (the name of which varies depending on what you select in the Go to what list), enter either of the following, and then select the Go To button:

- Enter a number identifying the position of the object within the total objects of that type in the document. (For example, if you select Footnote in the Go to what list, enter 4 to move to the fourth footnote in the document.)
- Enter + (plus sign) or – (minus sign) and then a number to move forward or backward by that many objects of the selected type.

Display different views of documents

You can display a document in different views that provide different types of information and make it easier to interact with specific document elements. For a closer look at the document content, you can increase the magnification of the content pane. If you want a high-level view of the content—for example, to quickly review all the pages of a document for length—you can decrease the magnification and view multiple pages at the same time.

Word has five views in which you can create, organize, and preview documents. Each view is suited to a specific purpose. The views are:

- **Print Layout**  This view displays a document on the screen the way it will look when printed. You can review elements such as margins, page breaks, headers and footers, and watermarks. This is the default view and the view you’ll use most frequently (or perhaps the only view you’ll use) when developing content.

- **Read Mode**  This view displays as much document content as will fit on the screen at a comfortable size for reading. In this view, the ribbon is replaced by one toolbar at the top of the screen with buttons for searching and navigating in the document. You can display comments, but you can’t edit the document in this view.

- **Web Layout**  This view displays the document the way it will look when viewed in a web browser so that you can review the way that text wraps to fit the window and the positioning of graphics. Web Layout view also displays page backgrounds and effects.

- **Outline**  This view displays the structure of a document as nested levels of headings and body text and provides tools for viewing and changing the hierarchy.
Draft This view displays the content of a document with a simplified layout so that you can quickly enter and edit text. Draft view doesn’t display images or layout elements such as headers and footers.

You manage the display of views and of window elements from the View tab of the ribbon. Three of the views are also available from the View Shortcuts toolbar near the right end of the status bar.

In the Views group on the View tab, the active view is shaded

While you’re developing a document in Print Layout view, the content pane displays the content of the document you’re working in. Each page is represented at the size specified in the document layout settings, with margins and other white space represented as they will appear when the document is printed. As you scroll through a multipage document, spaces appear between the pages. If you want to fit more content on the screen, you can hide the white space between pages and the margin content—including page headers and footers if the document has them—at the top and bottom of each page.

The bottom of one page and the top of the next page with and without white space
When working in Outline view or Draft view, you can display the paragraph style of each paragraph in the left margin, in an area called the style area pane. (It's not a pane, though; it's just a marginal area of the page.) By default, the style area pane width is set to zero inches wide, so it is effectively closed. If you want to display it, you can increase the width.

The style area pane is available only in Draft view and Outline view.

If your document uses styles to control the appearance and hierarchy of the content, you can display the headings in the Navigation pane and styles in the style area pane so that you can more quickly access and work with styles and styled content. You can also use the Navigation pane to display and move among page thumbnails or search results, as described in the previous topic.

Word has many other task-specific panes in which you can, for example, display Clipboard content, research terminology, review spelling, and format graphics. These panes usually appear to the right or left of the content pane and span its full height. Some of them can float within or outside the Word window or be docked to other sides of the window. Other chapters discuss these panes in the context of their functionality. Regardless of the purpose of the pane, however, you use the same methods to resize or move it.
You can change the space available for document content and app window elements by resizing the window, adjusting the relative sizes of the panes, or collapsing or hiding the ribbon. You can entirely hide not only the ribbon content but also the ribbon tabs and the app window title bar.

SEE ALSO For information about hiding, collapsing, and displaying the ribbon, see “Work with the ribbon and status bar” in Chapter 1.

When you want to focus on the layout of a document, you can display rulers and gridlines to help you position and align elements. You can also adjust the magnification of the content area by using the tools available in the Zoom group on the View tab and at the right end of the status bar.

![Zoom slider and dialog]

Change the content area magnification by using either the Zoom slider or the Zoom dialog

SEE ALSO For information about controlling paragraph formatting from the ruler, see “Apply paragraph formatting” in Chapter 4, “Modify the structure and appearance of text.”

If you want to work with different parts of a document at the same time, you can open the same document in a second window and scroll through each window separately, or you can split the current window into two panes and scroll through each pane independently.

You’re not limited to working with one document at a time. You can quickly switch among multiple open documents. If you want to compare or work with the content of multiple documents, you can simplify the process by displaying the documents next to each other.

A feature that can be invaluable when you’re fine-tuning the layout of a document in Word is the display of nonprinting characters (such as tabs, paragraph marks, and section breaks) that control the layout of your document. You can control the display of these characters for each window.
To switch among views of a document

- On the **View** tab, in the **Views** group, select the view you want.

- On the **View Shortcuts** section of the status bar, select the view button you want.

To hide or display the top and bottom page margins in Print Layout view

1. Point to the page break indicator between the end of one page and the start of the next page.
   - When the margins are displayed, including the page headers and footers, a gap between the pages indicates the page break.
   - When the margins are hidden, a horizontal line indicates the page break.

2. When the pointer changes to a representation of the page break with two arrows pointing away from the break when the margins are hidden or toward the break when the margins are displayed), double-click.

To show or hide the Navigation pane

- On the **View** tab, in the **Show** group, select or clear the **Navigation Pane** checkbox.

To adjust the size of the Navigation pane

- Point to the right border of the **Navigation** pane. When the pointer changes to a double-headed arrow, drag to the right or left.
TIP  The Navigation pane is available in all views except Read Mode. When you adjust the width of the Navigation pane, the pane content changes accordingly. For example, the Navigation pane displays fewer page thumbnails in a narrow pane and more page thumbnails in a wide pane.

To display the style area pane in Draft view or Outline view

1. In the Backstage view, select the Options page tab to open the Word Options dialog.
2. In the Word Options dialog, select the Advanced page tab.
3. On the Advanced page, scroll to the Display area (about halfway down the page) and change the Style area pane width in Draft and Outline views setting to any number greater than 0. Then select OK.

To resize the style area pane in Draft view or Outline view

1. Point to the right border of the style area pane.
2. When the pointer changes to a double-headed arrow, drag the border to the left or right.

To change the magnification of document content

1. Do either of the following to open the Zoom dialog:
   - On the View tab, in the Zoom group, select Zoom.
   - At the right end of the status bar, select the Zoom Level button.
2. In the Zoom dialog, select a Zoom to option or enter a specific percentage in the Percent box, and then select OK.

Or

- In the zoom controls at the right end of the status bar, do any of the following:
  - Drag the slider to the left to decrease the magnification or to the right to increase the magnification.
  - At the left end of the slider, select the Zoom Out button to decrease the magnification in 10-percent increments.
  - At the right end of the slider, select the Zoom In button to increase the magnification in 10-percent increments.
To display or hide rulers or gridlines in a document

- On the View tab, in the Show group, do either of the following:
  - Select or clear the Ruler checkbox.
  - Select or clear the Gridlines checkbox.

**SEE ALSO** For information about controlling document gridlines, see “Arrange objects on a page” in Chapter 10.

To display or hide nonprinting characters and formatting marks in a document

- On the Home tab, in the Paragraph group, select the Show/Hide ¶ button.
- Press Ctrl+* (asterisk).

**TIP** When entering an asterisk (*) on a standard keyboard rather than a numeric keypad, you must hold down the Shift key and then press the number 8 to enter an asterisk. So, in effect, you are pressing Ctrl+Shift+8.

To open a second window displaying the current document

- On the View tab, in the Window group, select New Window.

To split a window into two panes

- On the View tab, in the Window group, select Split.

To display a different open document

- On the View tab, in the Window group, select Switch Windows, and then select the file you want to view.
- Point to the Word icon on the Windows taskbar, and then select the thumbnail of the document you want to display.

To display multiple open documents at the same time

- On the View tab, in the Window group, select Arrange All.
Display and edit file properties

Properties are file attributes or settings, such as the file name, size, creation date, author, and read-only status. Some properties exist to provide information to computer operating systems and apps. You can display properties within the content of a document (for example, you can display the page number on the document pages). Word automatically tracks some of the file properties for you, and you can set others.

You can examine the properties attached to a file from the Info page of the Backstage view.

Some of the properties stored with a typical Word document

You can change or remove basic properties in the default Properties list or expand the list to make more properties available. You can also display the Properties dialog to access even more properties.
To display file properties
1. Display the Info page of the Backstage view. The Properties section in the right pane displays the standard properties associated with the document.

2. At the bottom of the Properties section, select Show All Properties to expand the section.

3. At the top of the Properties section, select Properties, and then select Advanced Properties to open the Properties dialog.

To edit file properties
1. In the Properties section of the Info page, select the value for the property you want to edit to activate the content box.

2. Enter or replace the property value, and then press Enter.

Or

- In the Properties dialog, do either of the following:
  - On the Summary tab, select the box to the right of the property you want to modify, and then enter or replace the property value.
  - On the Custom tab, select the property you want to modify in the Name list, and then enter or replace the property value in the Value box.

Save and close documents

When you save a document in Word, it is saved in the default .docx file format, but you can also select a different format from many other choices. For example, if you plan to distribute the document electronically to people who use a different word-processing program, you can choose a compatible format, or if you want to protect the document content, you can save it as a PDF file.
Manually save documents

You save a document the first time by selecting the Save button on the title bar or by displaying the Backstage view and then selecting Save As. Both actions open the Save As page, where you can select a storage location.

Save your document in an online location to access it from anywhere

You can save the document in a folder on your computer or, if you have an internet connection, in a folder on your OneDrive. If your company uses SharePoint, you can add a SharePoint site so that it is available from the location list on the Save As page, just like any other folder.

SEE ALSO For information about OneDrive, see the sidebar “Save files to OneDrive” later in this chapter.
Selecting Browse at the bottom of the left pane displays the Save As dialog, in which you assign a name to the document and specify the folder in which you want to save it.

![Save As dialog](https://example.com/save_as_dialog.png)

*The Save As dialog shows other files of the same type that are saved in the current folder*

**TIP** If you want to create a new folder in which to store the document, select New Folder on the Save As dialog toolbar.

After you save a document for the first time, you save changes by selecting the Save button on the title bar. A new version of the document then overwrites the previous version.

**To save a document for the first time**

1. Select the File tab to display the Backstage view.
2. In the left pane of the Backstage view, select **Save As**.
3. On the Save As page of the Backstage view, select a storage location, and then select a recently accessed folder in the right pane, or select Browse.

4. In the Save As dialog, browse to the folder you want to save the document in.

5. In the File name box, enter a name for the document.

6. If you want to save the document in a format other than the one shown in the Save As Type box, select the Save as type arrow and then select the file format you want.

7. In the Save As dialog, select Save.

To add a cloud storage location

1. On the Save As page of the Backstage view, select Add a Place.

2. In the Add a Place list, select a place, such as OneDrive.

3. In the Add a service dialog, enter the email address you use to sign in to the cloud storage service, and then select Next.

4. In the Sign in dialog, enter the password associated with the account, and then select Sign In to add the cloud storage location associated with that account to the Places list.

To save a copy of a document

1. Display the Save As page of the Backstage view.

2. Save the document with a different name in the same location or with any name in a different location. (You can’t store two documents with the same name in the same folder.)

To save a document without changing its name or location

- On the title bar, select the Save button.
- In the Backstage view, select Save.
- Press Ctrl+S.
Save files to OneDrive

When you save a document to OneDrive, you and other people with whom you share the document can work on it by using a local installation of Word or by using Word Online, which is available in the OneDrive environment. If you’re new to the world of OneDrive, here’s a quick tutorial to help you get started.

OneDrive is a cloud-based storage solution. The purpose of OneDrive is to provide a single place for you to store and access all your files. Although this might seem like a simple concept, it provides major value for people who use Word or other Microsoft 365 Apps on multiple devices, including Windows computers, Mac computers, iPads and other tablets, and Windows, iPhone, and Android smartphones.

For example, you can create a document on your desktop computer at work, edit it on your laptop at home, and review it on your smartphone while you’re waiting for your lunch to be served at a restaurant. If you use the full suite of Microsoft 365 Apps within your organization, you can even present the document in a Microsoft Teams meeting from your tablet PC, all while the document is stored in the same central location.

There are currently two types of OneDrive—one for personal use and one for business use:

- **OneDrive** This *personal* OneDrive storage site is provided free with every Microsoft account. Each OneDrive is linked to a specific account.

- **OneDrive for Business** An *organizational* OneDrive storage site is provided with every business-level Microsoft 365 subscription license. These storage locations are part of an organization’s Microsoft 365 online infrastructure.
You might have both types of OneDrive available to you. If you do, you can connect to both from within Word (or any Microsoft 365 app).

In this book, the personal and organizational versions are referred to generically as OneDrive sites.

To make OneDrive a realistic one-stop storage solution, Microsoft has chosen to support the storage of very large files (up to 10 gigabytes [GB] each) and to provide a significant amount of storage—from 5 GB to 1 terabyte (TB) per user, depending on your account type.

By default, documents that you store on your OneDrive site are password-protected and available only to you. You can share specific files or folders with other people by sending a personalized invitation or a generic link that allows recipients to view or edit files. You can access documents stored on your OneDrive in several ways:

- From within Word when opening or saving a file.
- Through File Explorer, when you synchronize your OneDrive site contents with the computer.
- Through a web browser. Personal OneDrive sites are available at https://onedrive.live.com; organizational OneDrive for Business sites have addresses linked to your Microsoft 365 business account, such as https://contoso-my.sharepoint.com/personal/joan_contoso_com.

Because OneDrive and OneDrive for Business file storage locations are easy to add to any version of Word, OneDrive is a simple and useful cloud storage option.
Automatically save documents

Word automatically saves new versions of documents stored on SharePoint or OneDrive; these files have an AutoSave button on the title bar that you can use to toggle the function off and on.

When the AutoSave function is turned on:

- If you’re working in a new, unnamed file, the app saves a temporary copy of the file to your default storage location.
- If you’re working in a previously saved file, the app saves a copy of the file to the location in which you opened or last saved it.

You can turn off the automatic file-saving function if you prefer to save changes manually (although this is not advisable).

To toggle AutoSave on or off

- In the title bar, select the AutoSave button.

SEE ALSO For information about working with document versions, see “Compare and combine documents” in Chapter 11, “Collaborate on documents.” For information about configuring other Word options, see “Change default Word options” in Chapter 16.

Save documents in other formats

Word uses file formats based on a markup language called Extensible Markup Language or, more commonly, XML. These file formats, called the Microsoft Office Open XML Formats, were introduced with Microsoft Office 2007.

Word offers a selection of file formats intended to provide specific benefits. Each file format has a file name extension that identifies the file type to the system. The file formats and file name extensions for Word files include the following:

- Word Document (.docx)
- Word Macro-Enabled Document (.docm)
- Word Template (.dotx)
- Word Macro-Enabled Template (.dotm)
- Word XML Document (.xml)
Older Word document types and other file types not specific to Word, such as text files, webpages, PDF files, and XPS files, are available from the Save As dialog.

Save a document in any of these file formats

The default file format for files created in Word is the .docx format, which provides the following benefits over the previous default .doc file format:

- **Decreased file size** Files are compressed when saved, decreasing the amount of disk space and bandwidth needed to store and transmit files.
- **Simpler retrieval and editing of content** XML files can be opened in text-editing apps such as Notepad.
- **Increased security** Personal data can be located and removed from the document, and files can’t store macros. (The .docm file format is designed for documents that contain macros.)

If you want to save a Word document in a format that can be opened by the widest variety of programs (including text editors that are installed with most operating systems), use one of these two formats:

- **Rich Text Format (*.rtf)** This format preserves the document’s formatting.
- **Plain Text (*.txt)** This format preserves only the document’s text.
If you want people to be able to view a document exactly as it appears on your screen, use one of these two formats:

- **PDF (*.pdf)**  This format is preferred by commercial printing facilities. Recipients can display the file in the Microsoft Edge browser or the free Microsoft Reader or Adobe Reader apps and can display and edit the file in Word or Adobe Acrobat.

- **XPS (*.xps)**  This format precisely renders all fonts, images, and colors. Recipients can display the file in the free Windows XPS Viewer app.

**TIP** Another way to create a PDF file or XPS file is by selecting that option when sending the document by email. For more information, see “Print and send documents” in Chapter 12, “Finalize and distribute documents.”

The PDF (Portable Document Format) and XPS (XML Paper Specification) formats are designed to deliver documents as electronic representations of the way they appear when printed. Both types of files can easily be sent by email to many recipients and can be made available on a webpage for downloading by anyone who wants them. However, the files are no longer Word documents. A PDF file can be converted to the editable Word format; an XPS file, however, cannot be opened, viewed, or edited in Word.
When you save a Word document in PDF or XPS format, you can optimize the file size of the document for your intended distribution method—the larger Standard file size is better for printing, whereas the Minimum file size is suitable for online publishing.

Maintain compatibility with earlier versions of Word

Word 2003 and earlier versions of Word used the .doc file format. You can open .doc files in Word 365, but some modern Word features will be unavailable.

When you open a file created in Word 2010 or an earlier version of Word, the title bar displays [Compatibility Mode] to the right of the document name. You can work in Compatibility mode, or you can convert the document to the current format by selecting the Convert button on the Info page of the Backstage view, or by saving a copy of the document with Word Document (*.docx) as the file type.

If you work with people who are using a version of Word earlier than Word 2007, you can save your documents in a format that they will be able to use by choosing the Word 97-2003 file format in the Save As Type list, or they can install the free Microsoft Office Compatibility Pack for Word, Excel, and PowerPoint File Formats from the Microsoft Download Center (located at download.microsoft.com). The Compatibility Pack doesn’t provide additional functionality in the older versions of the apps, but it does enable users of those earlier versions to open current documents, workbooks, and presentations.

To save all or part of a document in PDF format

1. Open the Save As dialog.
2. In the Save as type list, select PDF. The dialog content changes to provide additional options.
3. If you want to create a PDF file that has a smaller file size (but lower quality), select Minimum size (publishing online).
4. To modify any of the default settings, select the Options button, do any of the following, and then select OK:
   - Specify the pages to include in the file.
   - Include or exclude comments and tracked changes.
   - Include or exclude nonprinting elements such as bookmarks and properties.
   - Select compliance, font embedding, and encryption options.

5. If you don’t want to automatically open the new PDF file in your default PDF viewer, clear the Open file after publishing checkbox.

6. In the Save As dialog, select Save.

Close documents

Every time you open a document, a new instance of Word starts. When you close the file, you can exit that instance of Word. If you have only one document open, you can close the file and exit Word, or you can close the file but leave Word running.

To close a document

- At the right end of the title bar, select the Close button to close the document and the Word window.
- Display the Backstage view, and then select Close to close the document without exiting Word.
- On the Windows taskbar, point to the Word button to display thumbnails of all open documents. Point to the thumbnail of the document you want to close, and then select the Close button that appears in its upper-right corner.
Key points

- You can create simple and complex Word documents by starting with a template.

- You can open more than one Word document, and you can view more than one document at a time, but only one document can be active at a time.

- You can move the cursor by clicking or tapping in the text or by pressing keys and keyboard shortcuts.

- Information about a Word document is saved with the document as file properties that are available from the Info page of the Backstage view and from the document’s Properties dialog. Some properties are created and managed by Word, and others are customizable.

- Word 365 documents use the .docx file format. When you save a Word document, you specify its location on the Save As page of the Backstage view, and its name and file format in the Save As dialog. You can save a Word document as a different file type if necessary.

- You can display a variety of views of documents, depending on your needs as you create the document and the purpose for which you are creating it.
Practice tasks

Before you can complete these tasks, you must copy the book’s practice files to your computer. The practice files for these tasks are in the Word365SBS\Ch02 folder. You can save the task results in the same folder.

The Introduction includes a complete list of practice files and download instructions.

Create documents

Perform the following tasks:

1. Start Word and create a new, blank document.

2. Display the available templates for new documents. Scroll through the list of featured templates and note the types of documents you can create from them.

3. Search for a template that’s related to something you’re interested in. For example, you could use a search term such as food, school, children, or customers.

4. Preview a template from the search results. If the template preview includes multiple images, preview each of those by selecting the arrows below the image.

5. Without closing the preview window, preview the next or previous template by selecting the arrows to the sides of the preview window.

6. From the preview window, create a document based on the currently displayed template. Notice that the unsaved blank document remains open.

Open and move around in documents

In Word, perform the following tasks:

1. Display the **Open** page of the **Backstage** view.

2. If there are files in the **Recent** list, notice the groups they’re divided into, their file storage locations, and whether any are pinned to the list.

3. From the **Open** page, browse to the practice files folder, and open the **NavigateFiles** document.

4. In the second line of the document title, click or tap at the right end of the paragraph to position the cursor.

5. Use a keyboard method to move the cursor to the beginning of the line.

6. Use a keyboard method to move the cursor to the beginning of the word **Regulations**.

7. Use a keyboard method to move the cursor to the end of the document.

8. Use the scroll bar to move to the middle of the document.

9. Use the scroll bar to change the view of the document by one screen.

10. Open the **Navigation** pane.

11. In the **Navigation** pane, select the **Landscaping** heading to move the cursor directly to the selected heading.

12. At the top of the **Navigation** pane, select **Pages**. On the **Pages** page, scroll through the thumbnails to review the amount of visible detail, and then select the thumbnail for page 5 to move the cursor directly to the top of the selected page.

13. At the right end of the **Navigation** pane title bar, select the **Close** button (the X) to close the pane.

14. On the **Open** page of the Backstage view, pin the **NavigateFiles** document to the **Recent** list.

15. Close the document without saving it.
Display different views of documents

Open the DisplayViews document in Word, and then perform the following tasks:

1. If the document is not already in Print Layout view, display it in that view.

2. Switch to Web Layout view and scroll through the document to the end. Notice that the lines break differently and that there are no longer any page breaks.

3. Move the cursor back to the beginning of the document, and switch to Read Mode view.

4. On the Read Mode toolbar, select Tools to review the commands on the menu, and then select View to review the commands on that menu. Then, on the View menu, select Edit Document to return to Print Layout view.

5. In Print Layout view, hide the white space between pages. Scroll through the document and notice the change in the page lengths when the white space is hidden.

6. Open the Navigation pane and display the document headings. Adjust the pane width to the minimum necessary to display the headings.


8. In the Word Options dialog, set the width of the style area pane to 2”. Then select OK to return to the document.

9. Display the document in Draft view. Notice that the style area pane is visible along the left side of the document, but it is wider than necessary.

10. Drag the style area pane’s right border to the left until it takes up about half the original amount of space.

11. Display the document in Print Layout view, and use any method described in this chapter to change the magnification to 75%.

12. Split the window into two panes, position the cursor in the top pane, and then change the magnification to 100%. Notice that only the active pane changes. Then remove the split.

13. Use commands on the View tab to arrange the DisplayViews document and the document you created in the first set of practice tasks side by side on the screen.

15. Switch to the document you created in the first set of practice tasks. Display the rulers. Notice the effect of this action in the other open document.

16. Save and close both documents.

Display and edit file properties

Open the EditProperties document in Word, and then perform the following tasks:

1. On the Info page of the Backstage view, do the following:
   - Review the information in the Properties list. Notice the types of information that have been saved with the document.
   - Point to each of the property values and notice the values that you can edit.
   - Set the Title property to Welcome to Word.

2. Expand the Properties list to display all properties, and then do the following:
   - Notice the additional properties that were not previously visible. (If necessary, select Show Fewer Properties to switch back to the original list for comparison purposes.)
   - Point to the Manager and Author property values and notice that Check Names and Address Books buttons appear. Experiment with adding a Manager property from your address book.

3. Select the Properties header, and then display the advanced properties. In the EditProperties Properties dialog, do the following:
   - Compare the properties on the Summary tab with those in the Properties list. Notice the properties that you added in steps 1 and 2.
   - In the Author box, enter your name.
   - In the Keywords box, enter Word 365 new features.
   - Review the information on the General, Statistics, Contents, and Custom tabs. Notice the information that is available only in the Properties dialog.
   - Select OK.

4. Verify that the information you entered in the Properties dialog appears in the Properties list. If it doesn’t, save, close, and reopen the document to update the properties.
Save and close documents

In Word, perform the following tasks:

1. Save a copy of the **EditProperties** document in the practice file folder as **MyDocument**. Close the document and this instance of Word.

2. Close the document you created in the first task without exiting Word.

3. Close the remaining open documents and exit Word.
Index

SYMBOLS

=== (equal signs), typing, 139
--- (hyphens), typing, 139
~~~ (tildes), typing, 139
___ (underscores), typing, 139

NUMBERS

3D models, inserting and modifying, 259–264, 267–268
*.3mf file format, 259

A

Access app, 8
accessibility
  features, 25
  issues, 418–419
  structuring content for, 339
Accessibility Checker, 415, 417
Account page, 26–29
account settings, displaying, 29
add-ins, managing, 570–572, 581–582
Add-ins group, My Add-ins, 99
Advanced page, Word options dialog, 551–559
aligning text, 113–114, 122–123
Alt key. See keyboard shortcuts
Alt text
  adding to pictures, 212
  Table Properties dialog, 177
antonyms, displaying, 102
app settings, 26–30, 38
app window
  customizing, 28–29
  elements, 7
  maximizing, 21

apps, 8–9
Arrow keys. See keyboard shortcuts
artistic effects
  applying to pictures, 208
  applying to text, 130
attached documents, warning about, 48
attachments, sharing documents as, 424
attributions, including with pictures, 211–213
AutoCorrect feature, 139, 392, 398, 542
AutoRecover options, 545–546
AutoSave options, 545–546
AutoShapes, inserting, 220
AVERAGE function, 171
axes, charts, 279, 282, 284
axis titles, charts, 279, 282

B

background. See also page background
  choosing, 28–29
  removing from pictures, 206–207
background color, applying, 297
background watermark, inserting, 300–305, 318–319
Backstage view, 13–14, 25
bar charts, 271
Bar tab, 123
bibliographies, compiling, 460–466, 471–472
Binary GL Transmission Format, 259
Blank document, 42–46
BMP (bitmap) format, 198
bold text, formatting, 129
bookmarks, inserting, 434–437, 467
Border Lines, 139
Index

borders
  applying to page background, 299
  and shading, 121
brightness, adjusting for pictures, 208
browsing options, 53, 55–56
building blocks
  creating and customizing, 293, 525–529, 532
  displaying, 314
  modifying, 313
bullet symbol, changing, 137
bulleted list
  converting paragraphs to, 136, 138
  customizing, 137
  formatting, 135
  sorting alphabetically, 137
buttons with arrows, 11

charts
  components, 278–284
  creating, 270–275, 289–290
  custom templates, 274
  formatting, 284–288, 292
  modifying, 275–284, 290–291
  and spreadsheet content, 271–272
clarity or conciseness, checking, 399–400
Clipboard pane
  controlling, 92
  displaying, 89
  managing items in, 89
  using, 86–87
closing documents, 74, 80
cloud storage
  connecting to, 24, 29
  menu button, 7
collaboration tools
  coauthoring documents, 380–385. See also collaboration tools
  Co-authoring Options, General page, 537
column breaks, inserting, 165
column charts, 271
column headings formatting for tabbed lists, 167
column text, justifying, 164
columns. See also table columns
  formatting in tables, 177
  indenting, 165
  presenting information in, 158–165, 183–190
  resizing, 164–165
combo charts, 271
command and content search, 6
commands. See also ribbon
   increasing space between, 26
   making available, 11
comments
   changing user identification, 539
   displaying, 359
   inserting, 348–350
   navigating, 363
   reviewing and responding to, 360–362
Comments button, 15
comparing and combining documents, 367–368
Compatibility Checker, 415, 417
connected experiences, controlling, 540
Connected Services, 28
content
   structuring for accessibility, 339
   structuring manually, 122–125, 153
content changes, controlling, 370–380, 390
content pane
   displaying documents in, 54
   locating, 6
Continuous section break, 410
contrast, adjusting for pictures, 208
Copy Link command, 15
Copy option, 554
copying
   text, 89, 105–106
   text to Clipboard, 88
Cover Page gallery, 310, 314
cropping pictures, 203–204
crossed out, 351
cross-references
   going to, 440
   inserting, 434–437
cross-references, inserting, 467
Ctrl key. See keyboard shortcuts
cursor, moving, 54
custom themes. See also themes
   creating and managing, 517–519
   creating and modifying, 531
   deleting, 151
   saving and applying, 150
customizations, transferring, 565
Cut option, 554
cutting to Clipboard, 88
Cycle diagrams, 246
D
data labels, charts, 279, 282
data markers, charts, 278, 284
data source
   choosing and refining, 482–491, 506
   mail merge process, 474
data table, charts, 279, 282, 285
date and time field, inserting, 442–443
Decimal tab, 122–123
default Word options. See also Word Options
dialog
   advanced, 551–559
   changing, 534–539, 579
   display, 539
   file saving, 544–547
   language, 547–550
   proofing, 541–543
deleting
   characters, 92
   comments, 362
   custom themes, 151
   headers or footers, 309
   index entries, 459
   table elements, 183
   tables, 183
   text, 92, 105–106
design templates, previewing, 46
diagram shapes, entering text in, 250
diagrams. See also picture diagrams
  creating, 246–251, 265
  modifying, 251–256, 266
Dictate feature, 24
dictionaries
  installing, 98–99, 101–102
  managing, 402
display options, managing, 539, 555–556
Display pane, Scale and layout section, 21–22
document information, displaying in fields, 440–443, 468
Document Inspector, 414–417
document markup, 354–365, 388–389
document outlines
  displaying, 146
  expanding or collapsing, 146
  reorganizing, 322–327, 342
document parts, inserting, 310–315
document statistics, displaying, 101
document themes, changing, 147–151, 156.
  See also themes
documents. See also open documents;
  preformatted document parts; Show Document Content options; Track Changes;
  views of documents
  adding video content, 210
  closing, 74, 80
coauthoring, 380–385, 390
  comparing and combining, 365–369, 389–390
  creating, 42–47, 76
  displaying in content pane, 54
  displaying views, 56–62, 78–79
  inspecting, 415–417
  marking as final, 420
  marking up, 348–354, 387–388
  moving around in, 52–56, 77
  opening, 47–52, 77
  pinning to Recent file list, 50
  preparing for electronic distribution, 429–430
  previewing, 406
  printing and sending, 421–426, 430
  saving, 64–74, 80
  sharing links to, 381
  switching between, 59
  Word Compatibility Checker, 417
  .docx and .doc files, 48
Draft view, 57–58, 61
dragging selections, 86
drawing canvas, using with shapes, 220
drop cap, formatting, 133

e
  editing
    options, 552–553
    restricting, 370–374
    editing actions, undoing, 92
Editor pane, 393, 398
electronic distribution, preparing documents for, 429–430
email, sending documents by, 426
email messages, mail merge process, 480–482
encrypted passwords, 376, 379
endnotes and footnotes, inserting and
  modifying, 444–446, 468–469
envelopes and labels, creating, 497–504, 507–508
equal signs (===), typing, 139
equations, building, 229–232, 234–235
error bars, charts, 279, 282
error indicators, 392. See also text errors
Even Page section break, 410
Excel app, 8
Excel spreadsheets, inserting, 170
Excel worksheets
  data points, 275
  data series, 275

F
F keys. See keyboard shortcuts
*.fbx file format, 259
feedback, providing, 15–16, 31–36, 39
fields
  displaying document information in,
    440–443, 468
  mail merge process, 474
figures, tables of, 451
file formats, 48
file name, 7
file properties, displaying and editing, 63–64, 79
file saving options, 544–547
Filmbox Format, 259
Final designation, removing, 420
final document, marking, 420
Find and Replace dialog
  Find tab, 95
  Go To tab, 53, 55
finding and replacing text, 93–97, 106–107
First Line Indent, 118–119
folder location, changing default, 546
font color, changing, 130
Font dialog, opening, 132
fonts
  embedding, 547
  using, 126–129
footers and headers
  deleting, 309
  inserting, 307–309, 319
footnotes and endnotes, inserting and modifying, 444–446, 468–469
formatting
  charts, 284–288, 292
  controlling, 543
  page background, 294–299, 318
  restricting, 370
  tables, 183–190, 194
formatting commands
  locating, 221
  repeating, 132
Forms app, 8
Formula dialog, functions in, 171–172
Functionality options, 534
functions, Formula dialog, 171

G
General options, managing, 535–539
GIF (Graphics Interchange Format), 198
*.glb file format, 259
Go To tab, Find and Replace dialog, 53, 55
gradient, applying to page background, 5, 298
grammar checker, 392
Grammar Settings dialog, 394–400
graphic formats, 198–199. See also pictures
Grid and Guides dialog, opening, 336
gridlines, charts, 279, 285
gridlines and rulers, displaying, 59, 62, 282

H
hanging indent, 120
hard page break, 409
headers and footers
  deleting, 309
  inserting, 307–309, 319
heading styles, 145
help, getting, 31–36, 39
Help pane, displaying, 34
Help tab, 26
hidden characters, appearances, 122. See also characters
hidden objects, displaying, 337
hidden text, accessing, 14
hidden text, including, 409
hiding, ribbon, 20, 22
Hierarchy diagrams, 246
highlighting text, 131–132
Home page, 4–5, 42
hyperlinking to resources, 438–439
hyphenating document content, 165
hyphens (---), typing, 139

I
icons, inserting and formatting, 216–219, 239–240
Image options, 554
images. See pictures
importing text, 82–84, 104
indentation, changing in columns, 165
indenting
paragraphs, 119–120
tabbed lists, 167
indents, changing, 112, 118–120
indexes, creating and modifying, 453–459, 470
Insert Pictures menu, 25
Inspect Document area, 415
installing Office tools, 99
italic text, formatting, 129

J
JPEG (Joint Photographic Experts Group) format, 199
Justify alignment, 114

K
keyboard focus, changing using mouse, 606
keyboard shortcuts
actions, 608
aligning paragraphs, 596
Alt+function key, 600–601
Alt+Shift+function key, 601
applying character formatting, 594–596
applying paragraph formatting, 594–596
applying paragraph styles, 596
Backstage view, 605
browsing through text, 585
character formatting, 595
common tasks, 584
copying and moving text and graphics, 588–589
Ctrl+Alt+function key, 601
Ctrl+function key, 600
Ctrl+Shift+function key, 600
cursor movement, 54–55
customizing, 609–610
deleting text and graphics, 588
dialogs, 603–604
documents and webpages, 585–588
edit boxes in dialogs, 604
finding and replacing content, 608
finding and replacing text, 585
fonts, 594
footnotes and endnotes, 587
function keys, 598–599
help, 608–609
inserting characters in tables, 594
inserting special characters, 589–590
Language bar, 598
line spacing, 596
mail merge and fields, 597
moving around in tables, 593
Index

moving content in tables, 594
moving through documents, 592–593
Open dialog, 604
Outline view, 586
panes and galleries, 607
print and preview documents, 587
references, 587
reviewing documents, 587
ribbon navigation, 605
ribbon tabs, 22
Save As dialog, 604
selecting text and graphics, 590–591
Shift+function key, 599
switching views, 585
tables, 607
viewing and copying text formats, 595
webpages, 588
windows, 602–603

L
labels, mail merge process, 477–480
labels and envelopes, creating, 497–504, 507–508. See also mailing labels
language options, managing, 547–550
languages, translating from, 100, 102–103
Layout Options menu, 328–330
left alignment, 113
left indent, 118–120
left tab, 122–123
legend, charts, 279, 282, 284
letters, mail merge process, 476–477
licensing apps, buttons with arrows
line break, inserting, 124
line charts, 271
line spacing, 114. See also spacing
lines
on charts, 280, 282
selecting, 88
Link options, 554
LinkedIn Options, General page, 537, 539
links to documents, sharing, 381, 424, 426
List diagrams, 246
Listening prompt, microphone, 24
Lists app, 8
Live Preview feature, enabling or disabling, 538
Loop app, 8
lowercase text, 131

M
magnification, changing, 21, 61
mail merge process. See also merge fields
previewing and completing, 495–497
refreshing data, 492
starting, 475–482, 505
understanding, 474–475, 505
mailing labels, generating, 502–504. See also labels and envelopes
Manage Access command, 15
margins
hiding and displaying, 60
modifying, 407–408
Page Layout tab, 404
marking up documents, 354–365, 388–389
Math AutoCorrect feature, 233
Matrix diagrams, 246
MAX function, 171
Maximize button, 7
Merge field, 171
Merge field, inserting, 492–495, 506–507. See also mail merge process
microphone, Listening prompt, 24
Microsoft 365 apps, 8–9
MIN function, 171
Mini Toolbar
displaying, 85
enabling or disabling, 538
Minimize button, 7
More button, 12, 25
Mouse mode, 20
moving text, 89, 105–106

N
navigating pages, 406
Navigation pane
availability of, 61
browsing from, 55
displaying, 53
managing content in, 322–323
resizing, 60
showing and hiding, 55, 60
Next Page button, 406
Next Page section break, 410
nonprinting characters, displaying and hiding, 59, 62. See also characters
Normal template, 140
number style, changing for lists, 137–138
numbered list
converting paragraphs to, 136
formatting, 135

O
*.obj file format, 259
Object Format, 259
objects, rearranging on pages, 328–337, 343–344
Odd Page section break, 410
Office tools, installing, 99
OneDrive app, 8, 27, 52
OneNote app, 8
Online Pictures feature, 25
open documents, displaying, 62. See also documents
opening documents, 47–52
Orientation, Page Layout tab, 404, 409
orphans and widows, 409
outdenting paragraphs, 119–120
outline levels, managing, 145–147. See also document outlines
Outline view, 56, 58, 61, 324–327
Outlook, 8, 27

P
page background. See also background formatting, 294–299, 318
removing, 299
page breaks
controlling, 409–410
inserting and controlling, 412–413
removing, 413
page layout
controlling using tables, 338–340, 344
controlling with tables, 338–340
previewing and adjusting, 403–409, 428–429
page margins, hiding and displaying, 60
page numbers
inserting, 319
reformatting, 309
page orientation, changing, 409
Page Setup dialog, 405
pages, navigating, 406
panes, docking, 24
Paper Size, Page Layout tab, 404
paragraph alignment, setting, 114
paragraph borders and shading, configuring, 121
paragraph breaks, controlling, 409, 412–413
Paragraph dialog, opening, 114
paragraph formatting, 112–121, 152
paragraph marks, displaying and hiding, 124
paragraph spacing, 114–115. See also spacing
paragraphs, selecting, 88
passwords, using to restrict access, 376–379
Paste options, 90–91, 554
pasting items from Clipboard, 89
pattern, applying to page background, 298–299
PDF files, opening and editing, 51
Pen options, 554
People app, 8
picture diagrams, 246, 257–259, 267. See also
diagrams
Picture Format tab groups, 201
pictures. See also graphic formats; Stock images
   library
      Alt text, 212
      applying to page background, 296, 299
      artistic effects, 208
      attributions, 211–213
      brightness, 208
      color adjustments, 207
      color options, 201
      compressing, 209
      contrast, 208
      copying formatting, 209
      copyrights, 212
      crediting, 212
      cropping, 203
discarding changes, 209
ingoing and formatting, 200–209, 237–238
flipping, 203
framing or styling, 205
inserting, 25, 196–200, 237
moving, 196–200, 237
providing information about, 211–214, 238
removing backgrounds, 206
resizing, 196–200, 237
rotating, 203
selecting for editing, 203
sharpness, 208
pie charts, 271, 283
plot area, charts, 278, 284
*.ply file format, 259
PNG (Portable Network Graphic) format, 199
pointer and scroll bars, managing, 52
Polygon Format, 259
Position gallery, 328
PowerPoint app, 8
practice files, downloading, xv
preformatted document parts, inserting,
   310–315, 320. See also documents
previewing documents, 406
Previous Page button, 406
Print Layout view, 56, 60
Print page, 404
printing and sending documents, 421–426, 430
printing options, 557
Privacy Settings, General page, 536–537
Process diagrams, 246
proofing options, managing, 541–543
Proofreading page, Word Options, 401
properties, defined, 63
Protected View
   opening documents in, 50
   turning off, 5
pull quotes, 293
Punctuation Conventions, 397–398
punctuation marks, dictating, 84
Pyramid diagrams, 246
Q
Quick Access Toolbar, displaying and
customizing, 24, 560–564, 579–580
Quick Layout, applying to chart elements,
   280–281
Quick Parts. See building blocks
Quick Tables, 188–189. See also tables

R
Read mode, 56, 586
read-only access, 381, 420
Recent file list, pinning documents to, 50
Recent list, Open page, 49
recipients list, mail merge process, 489–491
records, mail merge process, 474
reference and research tools, 98–103, 107–108
reference mark, 444
reference tables, 451
Relationship diagrams, 246
Replace tab, Find and Replace dialog, 97
replacing and finding text, 93–97, 106–107
research and reference tools, 98–103, 107–108
resizing
pictures, 196–200
table columns, 180
table rows, 180
tables, 180
windows, 59
restricting
access using passwords, 376–379
actions, 370–376
restrictions, removing, 374–376
Results page, removing, 374–376
Results page, Navigation pane, 93, 95
Revisions pane, displaying, 359–360
ribbon. See also commands
adapting to environment, 18–19
collapsing, 12
customizing, 566–570, 580–581
displaying, 26
features, 10
hiding, 22
locating, 6
procedural instructions, 18–19
redisplaying, 22–23
and status bar, 16–23
tabs, 6
width of, 17
ribbon tabs, displaying, 22
right alignment, 113
right indent, 118–119
right tab, 122–123
rotating pictures, 203
rows. See table rows
rulers and gridlines, displaying, 59, 62, 119

S
Save commands, 7, 24
Save page, Word Options, 544
saving
custom themes, 150
documents, 64–74, 80
and sharing options, 558
screen clippings, inserting, 214–216, 239
screen resolution, changing, 21
ScreenTips, 11, 538
scroll arrows, 12
scroll bars and pointer, managing, 52
Search feature, 7, 24, 34
search results
finding, 95
narrowing, 94
searches, specifying, 95–96
searching text, 93–97
section breaks
formatting mark, 411
inserting, 412–413
removing, 413
using, 410
Security options, 534
security options, managing, 572–577, 581–582
selecting
  all content, 88
table cells, 179
table columns, 179
table rows, 179
tables, 180
text, 85–88, 105–106
Selection pane, displaying, 333
selections, releasing, 88
sending and printing documents, 421–426
Sentence case text, 131
shading and borders, configuring, 121
shapes
  drawing and modifying, 219–225, 228–229, 240
  formatting, 224–225
  moving in SmartArt graphics, 253
  removing from SmartArt graphics, 253
Share button, 15
Share function, 424
SharePoint app, 8, 28
sharing and saving options, 558
sharing links to documents, 381
sharpness, adjusting for pictures, 208
Shift key. See keyboard shortcuts
Show Document Content options, 555. See also documents
SketchUp Format, 259
*.skp file format, 259
Skype, 27
SmartArt
  diagrams, 246–249
  graphics, 251–256
soft page break, 409
sorting data in tables, 178
sources, citing, 460–466, 471
space, increasing between commands, 26
spacing, adjusting, 116–117, 134. See also line spacing; paragraph spacing
speaking, Dictate feature, 24
spelling, checking, 365, 399–400
spreadsheet content
  and charts, 271–272
  inserting, 170
special characters, 589–590
Start Up Options, General page, 537
starting Word, 4–5, 37
status bar, 6, 23
StereoLithography Format, 259
*.stl file format, 259
Stock images library, 217. See also pictures
storage locations, connecting to, 28
Strikethrough button, 129
struck through, 351
style area pane
  displaying, 61
  resizing, 61
  setting, 58
style set, changing, 144
styles
  applying to text, 140–147, 154–156
  creating and modifying, 510–517, 530
  displaying headings for, 58
Styles gallery
  adding styles to, 144
  removing styles from, 144
Styles pane
  displaying previews in, 144
  hiding previews in, 144
  opening, 142–144
Subscript button, 130
subscription options, 8–9, 30
SUM function, 171
Superscript button, 130
SVG (scalable vector graphics) format, 199, 218
Sway app, 8
symbols, inserting, 226–227
synonyms, displaying, 102

T

tab character, inserting, 124
tab setting options, 123
tab stops, setting and removing, 124–125
tabbed lists. See also lists
  converting to tables, 175
  creating, 192
  using, 166–168
table cells
  adding calculations to, 178
  aligning text in, 178
  formatting, 177
  inserting, 181–182
  merging, 182
  selecting, 179
  splitting, 182
table columns. See also columns
  inserting, 180
  resizing, 180
  selecting, 179
table elements, deleting, 183
table rows
  formatting, 177
  inserting, 181
  resizing, 180
  selecting, 179
table structure, modifying, 172–173
table styles, applying to tables, 186–187
tables. See also Quick Tables
  applying borders and shading, 186
  controls and tool tabs, 171
  converting tabbed lists to, 175
  creating, 173–174
  deleting, 183
drawing, 174
entering data, 175
formatting, 183–190, 194
layout options, 176–177
navigating, 175
nesting, 338
presenting information in, 168–173, 192–193
resizing, 180
selecting, 180
sorting data in, 178
updating calculations, 178
using to control page layout, 338–340, 344
tables of authorities, 451
tables of contents, creating and modifying, 446–453, 469
tables of figures, 451
tabs, aligning, 124–125
Tabs dialog, opening, 124
Teams app, 8
templates
  availability of, 44
  basing documents on, 42, 47
  for charts, 274
  clearing, 47
  creating and attaching, 520–525, 531
default location, 545
text
  adding to shapes, 220–221
  aligning, 122–123
  applying artistic effects to, 130
  AutoCorrect As You Type page, 139
  changing case of, 131
  copying, 89, 105–106
  copying formatting to, 132
  crossing out, 129
  cutting to Clipboard, 88
  deleting, 92, 105–106
  entering and importing, 82–84, 104
  entering into diagram shapes, 250
Index

finding and replacing, 93–97, 106–107
formatting while typing, 139
highlighting, 131–132
moving, 89, 105–106
releasing selections, 88
replacing, 97
searching for, 95
selecting, 85–88, 105–106
styles, 140–147, 154–156
translating, 102–103
undoing actions, 92
text boxes, inserting and linking, 311, 316
text effects, 128
text errors, locating and correcting, 392–403, 428. See also error indicators
texture, applying to page background, 294, 298
text-wrapping options, 329–330
theme elements, changing, 150
themes. See also custom themes; document themes
   applying, 150
   applying to documents, 149
   changing, 150
   choosing, 28
   saving, 150
thumbnails, 12
tildes (~~~), typing, 139
time and date field, inserting, 442–443
title bar, locating, 6
titles, charts, 285
To Do app, 8
TOC styles, 449–450
toGGLE cASE, 131–132
tool tab, 10
touch interaction, 23
Touch mode, 20
Track Changes, 350–354, 363–364, 539. See also documents
Translator tool, 100, 102–103
trendline, charts, 280, 282
Trust Center options, configuring, 572–577, 581–582
U
underlined text, formatting, 129
underscores (___), typing, 139
undoing actions, 92
unencrypted passwords, 376
updates, managing, 30, 38
up/down bars, charts, 280, 282
UPPERCASE text, 131
user account menu button, 7
user identification, changing in Track Changes, 539
user interface customizations, transferring, 565
User interface options, 534
V
vertical spacing, configuring, 114–117
video content, adding to documents, 210
views of documents. See also documents
displaying, 56–62
switching between, 60
vocabulary, checking, 397
W
watermark, inserting, 300–305, 318–319
Web Layout view, 56
widows and orphans, 409
window management, 7
windows
   managing, 59
   opening, 62
   resizing, 59
   splitting into panes, 62
Index

Word
  file formats, 48
  starting, 4–5, 37
word definitions, displaying online, 101
Word Online, 9
Word Options dialog, 30–31, 538. See also
default Word options
word processing, 3
Word user interface
  apps, 8–9
  Backstage view, 13–14
  capabilities, 5–6
  collaboration tools, 15
  ribbon of commands, 10–12, 16–17, 20–23
  status bar, 16–17, 20–23
  suggesting changes to, 36
  title bar, 7
  working in, 37
WordArt, 128
words, selecting, 88

X
  x-axis, charts, 278
  Xbox Live, 27

Y
  y-axis, charts, 278

Z
  z-axis, charts, 278
  zoom controls, using, 61
  Zoom dialog, opening, 61
  Zoom to Page button, 406